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Introduction
The ShoreTel Workgroup Real-Time Monitor (Workgroup Monitor) client application displays 
updated real-time workgroup performance information, in tables and in graphical form, intended 
for those in a workgroup supervisor role.  Various thresholds can be customized to visually and 
audibly indicate important status changes in the monitored workgroups.  Abandoned calls can 
be shown in detail and return calls immediately made from the Workgroup Monitor client 
application.

The Workgroup Monitor client communicates with the Workgroup Monitor server component, 
which collects and provides the data to any/all Workgroup Monitor clients.

The Workgroup Monitor client application will communicate to the server component via a 
remote interface, retrieving data points for workgroups that are being monitored by that client. 
Data points displayed within the client monitor are updated periodically.

Below find a description of the Workgroup Monitor client followed by the installation guide.

Page 3

960 Stewart Drive, Sunnyvale, CA 94085  USA  +1 (800) 425-9385 Toll Free  +1 (408) 331-3300 Tel.  shoretel.com

http://shoretel.com/


ShoreTel Workgroup  Monitor  Client  Application

Main Window
The monitor itself will consist of a main window, which exists simply to launch and contain the 
various child windows.  Child windows monitor various workgroups or display data in various 
ways.  Multiple child windows may exist within the main window.  The child windows each 
display a different functional set of data targeting different areas of interest for the workgroup 
supervisor/manager.

Workgroup Monitor – Main Window

The main window provides access to all the functions of the Workgroup Monitor in the top menu 
selections.  It also shows the server status at the lower left.

The  “File” menu contains the “Exit” function.

The “Edit” menu contains functions for copying child or main window images to the clipboard 
(useful for pasting into other programs).

The “Monitor” menu contains most of the functionality to display child windows, described later.

The “Tools” menu contains the “Options” function, described in the following section.

Under the “View” menu selection you can control the visibility of the status bar (bottom of main 
window), the menu bar (menu at the top of the main window), and the child window title bars 
(the caption at the top of each child window).

Notes concerning the “View” options:

You can use the ALT key to restore the menu bar when it is not visible.

When child window titles are invisible, in order to move the child window, mouse over and click 
to “grab” where the  glyph appears.  Reposition the window as desired.  The glyph will 
disappear a few seconds after the mouse leaves the child window.
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The “Windows” menu selection lists each of the child windows within the main window and 
provides functions for “tiling” or “cascading” the child window positions as well as closing all the 
child windows.

The “Help” menu item contains access to the help screen and “About” selections.  Use “About” 
to display the version of the program.
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Configuration  of  Options
After installing the Workgroup Monitor client application, the first thing to do is to configure the 
set of workgroups you are interested in monitoring.

The client application will be able to obtain, via communication with the server component, the 
list of workgroups defined on the Shoretel system.  The client will allow the user to indicate the 
workgroup or set of workgroups that the user is interested in (and will remember these).  In 
addition, the application will remember the type and position of the child windows between runs, 
if so configured.

The Workgroup Monitor will also be able to set threshold values for each of the workgroups the 
user has chosen.  There are two threshold levels, a yellow “warning” level and a red “urgent” 
level.  The threshold settings determine the color of the text in various windows to indicate 
possible action.

Configuration of the Workgroup Monitor client is accomplished by selecting “Options” under the 
“Tools” selection in the main window.

Workgroup Monitor – Main Options Menu

On the main options window, one can configure the connection to the Workgroup Monitor server 
(host name or IP address and TCP port), the parameters for making outgoing phone calls from 
the client (extension number, external trunk access code, and the telephone country code of 
residence), and various other options.  The program tries to pre-configure these values with the 
correct settings but it is best to verify after installation to be sure.
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Options – My Workgroups
From the main options window, select “My Workgroups…” to display the workgroup selection 
window.  Select “Thresholds…” to display the threshold configuration window.  Select “Other 
Options…” for the miscellaneous other configuration options.

Workgroup Monitor – Workgroup Selection Window

Use the workgroup selection window to select which workgroups available on your ShoreTel 
system will be displayed on the Workgroup Monitor menus and windows.  These are called “My 
Workgroups”.
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Options - Thresholds

Workgroup Monitor – Thresholds Window

Use the threshold window to select workgroups displayed from the “My Workgroups” list.  The 
threshold levels can be set using the selections on the right.  Each workgroup can have two sets 
of thresholds, “Yellow” thresholds for initial warnings and “Red” thresholds for more severe 
events.  To that end, the “Yellow” values should be less than the “Red” values (if not, the “Red” 
values will take precedence).  Values can be set for “calls in queue”, “maximum wait”, and 
“average wait” for each Workgroup.

Clicking on the word “Yellow” or “Red” will display a window allowing you to choose the color 
you wish to use for that threshold level.  It does not have to be yellow for “Yellow” or red for 
“Red” although those are the defaults.

If the “Audible” box is checked, an audible alert is played through the computer speakers when 
any of the particular threshold values are reached.  The Windows sound associated with 
“Asterisk” program events is played when crossing any “Yellow” alert while for “Red” alerts, the 
Windows sound associated with “Exclamation” events is played (these program event sounds 
are configured under Windows in the Control Panel “Sounds and Audio Devices” settings).

Note the “Enable Thresholds” selection box must be selected in order for any threshold settings 
to take effect for the selected workgroup.
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Options - Other

Workgroup Monitor – Other Options Window

The “Other Options” window allows you to configure a few global settings.  In the example 
screen above, we see that all “Abandoned Call” windows will show calls from the past 30 
minutes and those screens will refresh with new data every 75 seconds.

In addition, we see the “Include Workgroup overflow wait time” checkbox.  This option only 
applies to Workgroups configured, in ShoreWare Director, with an overflow target and the 
“Maintain Wait Time” setting checked.  If the “Include Workgroup overflow wait time” box is 
checked, all Workgroup waiting time values displayed in Workgroup Monitor will include the time 
waiting in prior overflowed groups.  If not checked, the time will include only time waiting in the 
current queue.
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Monitor  Child  Windows
Under the “Monitor” selection of the main window, appear the choices for various monitor child 
windows:• “At a Glance”• “Workgroup Trend”• “Abandoned Calls”• “Agent View”• “Agent State Summary”• “Agent Calls Answered”• “Agent Connect %”• “Large Value Displays”

Other than the “At a Glance” window, the child windows relate to particular Workgroups and so 
their options under the “Monitor” selection are populated with the set of “My Workgroups” as 
configured.

One child window, “Agent Detail”, can only be accessed via the “Agent View” window.  There is 
no choice for “Agent Detail” within the main “Monitor” selection.

Each of the child window types are described in the sections to follow.
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Monitor Child Window – At A Glance

Workgroup Monitor – At A Glance Window

The “At a Glance” window shows important high-level information for each workgroup in the set 
of “My Workgroups”.  For each workgroup, it will display the workgroup name and number along 
with various data points for that workgroup.  The display will be color-coded based on threshold 
settings as configured.  Double click a workgroup to display the “Trend” window for that 
workgroup.  Right click a workgroup to select one of the many other monitor windows for that 
workgroup.

The “At a Glance” window can also be configured to show fewer data points by right clicking and 
selecting “Add/Remove Columns” anywhere within the window.
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Monitor Child Window – Trend

Workgroup Monitor – Trend Window

The “Trend” window shows information on the particular chosen workgroup for a particular 
chosen “trend time” of the past ½ , 1, 2, 4, or 8 hour(s).  In the heading it displays current 
number of calls in the queue, current longest wait time, current average wait time, number of 
calls arrived during the trend time, and number of calls abandoned during the trend time.  In 
addition, it displays a line chart showing a moving graph of one or more of the following 
statistics:  Number of call arrivals, maximum number of calls in queue and the number of 
abandoned calls.  Each data point represents a number of calls for that particular minute in time.

To choose the trend time and the statistics to be displayed, right click anywhere on the graph 
area to pop up the selection menu (as shown in the display above).  Double-clicking will 
advance to the next trend time.
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Monitor Child Window – Abandoned Calls

Workgroup Monitor – Abandoned Calls Window

The “Abandoned Calls” window shows information on a particular chosen workgroup and 
displays the list of past abandoned calls, including time received, caller ID (if it was available), 
the DNIS (if available) and duration waited before abandoning.  Individual calls may be selected 
(double click or right click) and an outbound call back initiated by the supervisor (right click pop 
up is shown in the display above).

See “Other Options” configuration window, described previously, to configure number of 
minutes of calls to display and how often to update the data.

Note abandoned calls from all workgroups within the “My Workgroups” set can be combined into 
a single display screen by choosing “All Workgroups”.  The “All Workgroups” screen is the same 
as above with the addition of a Workgroup column.
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Monitor Child Window – Agent View

Workgroup Monitor – Agent View Window

The “Agent View” window shows important agent status information for the chosen Workgroup. 
For each agent, it will display the agent name and number along with various data points for 
each agent.

“Agent State” will show “Logged In”, “Logged Out” or “Wrapup” reflecting the agent’s Workgroup 
state.  “Agent State Duration” shows time in that agent state.

“Call State” reflects the Workgroup related call state and will show one of “Idle”, “WG Call” or 
“Non-WG Call”.  “Call State Duration” shows time in that call state.

“Detailed Call State” shows the low level telephony state of the call, one of “Idle”, “Connected 
In”, “Connected Out”, “Party on Hold”, “Being Held”, “Ringing”, “Dialing Out”, “Conferenced”, or 
“Receiving Tone”.

“WG Calls Answered” and “WG Calls % Connect” are statistical columns showing number of 
Workgroup calls answered and percent of time connected on Workgroup calls within a time 
period, which can be configured by right clicking and selecting “Set Time Period”.

The “Agent View” window can also be configured to show fewer data points by right clicking and 
selecting “Add/Remove Columns” anywhere within the window.

To open the “Agent Detail” window for the chosen agent, right click and select “Open Agent 
Detail”.
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Monitor Child Window – Agent Detail

Workgroup Monitor – Agent Detail Window

The “Agent Detail” window shows the list of all calls to/from the selected agent in a given time 
period.  Active calls are highlighted in green.  This window can only be launched from the 
“Agent View” window (described earlier).

To set the time period right click within the window and select “Set Time Period”.

Page 15

960 Stewart Drive, Sunnyvale, CA 94085  USA  +1 (800) 425-9385 Toll Free  +1 (408) 331-3300 Tel.  shoretel.com

http://shoretel.com/


Monitor Child Window – Agent State Summary

Workgroup Monitor – Agent State Summary Window

The “Agent Summary” window shows the summary of current agent states for that particular 
Workgroup, the states being Idle, Wrapup, on a Workgroup Call, on a non-Workgroup call, and 
Logged Out.  Note Wrapup will be shown if an agent is in Wrapup and on a non-Workgroup call.

Logged out agents can be excluded from the chart by double-clicking or right clicking to make 
that selection (the right click pop up is shown in the display above).

Page 16

960 Stewart Drive, Sunnyvale, CA 94085  USA  +1 (800) 425-9385 Toll Free  +1 (408) 331-3300 Tel.  shoretel.com

http://shoretel.com/


Monitor Child Window – Agent Calls Answered

Workgroup Monitor – Agent Calls Answered Window

The “Agent Calls Answered” window shows a bar chart for each agent in the chosen Workgroup 
indicating the number of Workgroup calls answered within the specified time period.

Right click anywhere within the window to select the time period, to “Exclude” logged out agents 
from the chart, or to select a color scheme for the chart.
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Monitor Child Window – Agent Connect %

Workgroup Monitor – Agent Connect % Window

The “Agent Connect %” window shows a bar chart for each agent in the chosen Workgroup 
indicating the percentage of time connected on a Workgroup call within the specified time 
period.

Right click anywhere within the window to select the time period, to “Exclude” logged out agents 
from the chart, or to select a color scheme for the chart.
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Monitor Child Window – Large Value Displays

Workgroup Monitor – Large Value Display Window (Example)

These “large value” displays are simple informational windows intended to produce readable 
results when shown on a large video display.  The font will “grow” as the child window is resized 
larger.  In this way, if desired, one could fill the whole display with a single large “Calls in 
Queue” value.

The following data points are available:• “Calls In Queue” – Current number of calls in queue.• “Longest Call Wait” – Wait time of longest call in queue.• “Average Call Wait” – Average wait time of all calls in queue.• “Agents Idle/Busy” – Three values in one display:  Number of agents idle (logged 
in but not on any call nor in Wrapup), number busy  (on a Workgroup call or in 
Wrapup), and number on a non-Workgroup call.• “Agents Wrapup” – Number of agents in Wrapup state.• “Agents Logged In” – Number of agents logged in.• “Agents Logged Out” – Number of agents logged out.• “Agents Idle” – Number of agents idle (logged in but not on any call and not in 
Wrapup).• “Agents On Workgroup Call” – Number of agents currently on a Workgroup call.• “Agents On Non-Workgroup Call” – Number of agents currently on a non-
Workgroup call.
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Each window will display a particular data point for the chosen Workgroup (as usual, any of “My 
Workgroups” set).  An exception is that “Calls In Queue” also allows you to display a window 
with the total of all calls in all “My Workgroups”.  The relevant windows (showing values where a 
threshold can be configured) will be color-coded based on threshold settings as configured.
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ShoreTel Workgroup  Real-Time Monitor  Installation
The Workgroup Monitor consists of server and client components.

Compatibility
The Workgroup Monitor server component must be loaded on a ShoreTel Director 
(“headquarters”) server or a ShoreTel DVS.

The Workgroup Monitor client should be loaded on the desktop computer of each client user. 
You may need to enter the name or IP address of the Workgroup Monitor server computer when 
installing each Workgroup Monitor client.

The client user must have any version of ShoreTel Call Manager software installed.  Call 
Manager does not need to be running in order to use Workgroup Monitor.

Note Workgroup Monitor requires Microsoft’s .NET framework 2.0.50727.  The installer will 
indicate and install this Microsoft update if it not already installed.  Alternatively, you may use 
Microsoft’s Windows update to install this prerequisite or it is available directly: 
http://www.microsoft.com/downloads/details.aspx?familyid=0856eacb-4362-4b0d-8edd-
aab15c5e04f5&displaylang=en.

Workgroup Monitor Server Installation Instructions
Install Workgroup Monitor server component on a ShoreTel Director Server or DVS by 
launching WGMonitorServerSetup.exe.  The user installing must have the rights, under 
Windows, to install new software.  There are no settings during the install.  Accept the license 
agreement and all defaults until install is complete.

The result is a new Windows service called “STPS Workgroup Monitor” is installed on your 
server.  No maintenance or adjustment should be necessary.

Workgroup Monitor Client Installation Instructions
Install Workgroup Monitor on a client computer by launching WGMonitorClientSetup.exe.  The 
user installing must have the rights, under Windows, to install new software.  The following 
screen captures show the sequence of dialogs during installation.
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Click “Next”

Accept the license terms and click “Next”
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An installation folder other than the default can be specified.  Additionally, the “Everyone” versus 
“Just Me” setting controls whether Windows will allow all other users who may log into this 
particular machine the ability to run this application.  If you are an administrator installing this 
application for other users, be sure to change the setting to “Everyone”.

Click “Next” to begin the install
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Click “Close” and installation will be complete
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Logging
Both server and client components log errors and potentially debug tracing to a log file.

Server
The Workgroup Monitor server logging is controlled using the file log4net.config which is placed 
in the installation folder (default is C:\Program Files\ShoreTel\Workgroup Monitor Service).

The logging level can be altered by editing log4net.config.  There are 2 pertinent levels, INFO 
and DEBUG.  To change, edit the line in log4net.config containing:

      <level value="INFO" />

The value (within quotes) may be INFO or DEBUG.  Editing and saving log4net.config causes 
the logging level to change immediately.  It is suggested the level be kept to INFO unless a 
specific issue is being investigated in which you may be instructed to change the level to 
DEBUG.

The resulting log files will also be in the installation folder and will be of the form 
STWGMonitorService.<day of week>.log.

Client
The Workgroup Monitor client logging is controlled using the file log4net.config which is placed 
in the installation folder (default is C:\Program Files\ShoreTel\Workgroup Monitor) on the client 
machine.

The logging level can be altered by editing log4net.config.  There are 2 pertinent levels, INFO 
and DEBUG.  To change, edit the line in log4net.config containing:

      <level value="INFO" />

The value (within quotes) may be INFO or DEBUG.  Editing and saving log4net.config causes 
the logging level to change immediately.  It is suggested the level be kept to INFO unless a 
specific issue is being investigated in which you may be instructed to change the level to 
DEBUG.

The resulting log files will be in the folder referenced by %AppData
%\ShoreTel\WGMonitorClient (you can type that reference into Windows Explorer to locate) and 
will be of the form WGMonitorClient.<day of week>.log.
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